Chapter 307

Superiority by a Margin Tests for Two Total Variances in a 2×2M Replicated Cross-Over Design

Introduction

This procedure calculates power and sample size of superiority by a margin tests of total variabilities (between + within) from a 2×2M replicated cross-over design. This routine deals with the case in which the statistical hypotheses are expressed in terms of the ratio of the total variances.

This design is used to compare two treatments which are administered to subjects in different orders. The design has two treatment sequences. Here, $M$ is the number of times a particular treatment is received by a subject.

For example, if $M = 2$, the design is a 2×4 replicated cross-over. The two sequences might be

sequence 1: C T C T
sequence 2: T C T C

It is assumed that either there is no carry-over from one measurement to the next, or there is an ample washout period between measurements.
Technical Details

This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018), pages 227 - 230.

Suppose $x_{ijkl}$ is the response in the $i$th sequence ($i = 1, 2$), $j$th subject ($j = 1, \ldots, N_i$), $k$th treatment ($k = T, C$), and $l$th replicate ($l = 1, \ldots, M$). The mixed effect model analyzed in this procedure is

$$x_{ijkl} = \mu_k + \gamma_{ikl} + S_{ijkl} + e_{ijkl}$$

where $\mu_k$ is the $k$th treatment effect, $\gamma_{ikl}$ is the fixed effect of the $l$th replicate on treatment $k$ in the $i$th sequence, $S_{ij1}$ and $S_{ij2}$ are random effects of the $ij$th subject, and $e_{ijkl}$ is the within-subject error term which is normally distributed with mean 0 and variance $V_k = \sigma_{Wk}^2$.

Unbiased estimators of these variances are found after applying an orthogonal transformation matrix $P$ to the $x$‘s as follows

$$z_{ijkl} = P'x_{ijkl}$$

where $P$ is an $m \times m$ matrix such that $P'P$ is diagonal and $\text{var}(z_{ijkl}) = \sigma_{Wk}^2$.

Let $N_s = N_1 + N_2 - 2$. In a $2 \times 4$ cross-over design the $z$‘s become

$$z_{ijk1} = \frac{x_{ijkl1} + x_{ijkl2}}{2} = \bar{x}_{ijkl},$$

and

$$z_{ijk2} = \frac{x_{ijkl1} + x_{ijkl2}}{\sqrt{2}} = \bar{x}_{ijkl}.$$  

In this case, the within-subject variances are estimated as

$$s_{WT}^2 = \frac{1}{N_s(M - 1)} \sum_{i=1}^{N_i} \sum_{j=1}^{N_i} \sum_{l=1}^{M} (z_{ijkl} - \bar{z}_{i,lT})^2$$

and

$$s_{WC}^2 = \frac{1}{N_s(M - 1)} \sum_{i=1}^{N_i} \sum_{j=1}^{N_i} \sum_{l=1}^{M} (z_{ijkl} - \bar{z}_{i,LT})^2$$

Similarly, the between-subject variances are estimated as

$$s_{BT}^2 = \frac{1}{N_s} \sum_{i=1}^{N_i} \sum_{j=1}^{N_i} (\bar{x}_{ijT} - \bar{x}_{LT})^2$$

and

$$s_{BC}^2 = \frac{1}{N_s} \sum_{i=1}^{N_i} \sum_{j=1}^{N_i} (\bar{x}_{ijC} - \bar{x}_{LC})^2$$

where

$$\bar{x}_{i,k} = \frac{1}{N_i} \sum_{j=1}^{N_i} x_{ijkl}.$$
Now, since $E(s_{BK}^2) = \frac{\sigma_{BK}^2 + \sigma_{WK}^2}{M}$, estimators of the total variance are given by

$$\hat{\sigma}_{TK}^2 = s_{BK}^2 + \frac{(M - 1)}{M} \hat{\sigma}_{WK}^2$$

The sample between-subject covariance is calculated using

$$s_{BTC}^2 = \frac{1}{N_s} \sum_{i=1}^{N_s} \sum_{j=1}^{2} (\bar{x}_{ijT} - \bar{x}_{i.T})(\bar{x}_{ijC} - \bar{x}_{i.C})$$

Using this value, the sample between-subject correlation is easily calculated.

**Testing Variance Superiority**

The following statistical hypotheses are used to test for total variance non-inferiority.

$$H_0: \frac{\sigma_{WT}^2}{\sigma_{TC}^2} \geq R_0$$ versus $$H_1: \frac{\sigma_{WT}^2}{\sigma_{TC}^2} < R_0,$$

where $R_0$ is the superiority limit.

Let $\eta = \sigma_{WT}^2 - R_0 \sigma_{TC}^2$ be the parameter of interest. The test statistic is $\hat{\eta} = \hat{\sigma}_{WT}^2 - R_0 \hat{\sigma}_{TC}^2$.

**Superiority by a Margin Test**

For the superiority test, compute the limit $\hat{\eta}_U$ using $\hat{\eta}_U = \hat{\eta} + \sqrt{\Delta_U}$

Reject the null hypothesis if $\hat{\eta}_U < 0$.

The $\Delta$ is given by

$$\Delta_U = h(1 - \alpha, N_s - 1) \lambda_i^2 + h(\alpha, N_s - 1) \lambda_i^2 + h(1 - \alpha, N_s(M - 1)) \left[\frac{(M - 1) \hat{\sigma}_{WT}^2}{M}\right]^2 + h(\alpha, N_s(M - 1)) \left[\frac{(M - 1) \hat{\sigma}_{WC}^2}{M}\right]^2$$

where

$$h(A, B) = \left(1 - \frac{B}{\chi_{A,B}^2}\right)^2$$

$$\lambda_i^2 = \left(\frac{s_{BTC}^2 - s_{BC}^2 \pm \sqrt{(s_{BTC}^2 + s_{BC}^2)^2 - 4(R_0)s_{BTC}^4}}{2}\right)$$ for $i = 1, 2$

and $\chi_{A,B}^2$ is the upper quantile of the chi-square distribution with $B$ degrees of freedom.
Power

Superiority by a Margin Test
The power of the superiority test is given by

\[
\text{Power} = \Phi \left( z_\alpha - \frac{(R_1 - R_0) \sigma_{TC}^2}{\sqrt{\sigma^2/N_s}} \right)
\]

where

\[
R_1 = \frac{\sigma_{TR}^2}{\sigma_{TC}^2}
\]

\[
\sigma_{TR}^2 = R_1 \sigma_{TC}^2
\]

\[
\sigma^2 = 2 \left[ \left( \frac{\sigma_{BT}^2 + \sigma_{WT}^2}{M} \right)^2 + R_0 \left( \frac{\sigma_{BC}^2 + \sigma_{WC}^2}{M^2} \right)^2 + \frac{(M - 1) \sigma_{WT}^4}{M^2} + \frac{(M - 1) R_0^2 \sigma_{WC}^4}{M^2} - 2 R_0 \sigma_{BT}^2 \sigma_{BC}^2 \rho^2 \right]
\]

A simple binary search algorithm can be applied to the power function to obtain an estimate of the necessary sample size.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and power.

Solve For

Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will select either Power or Sample Size.

Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis when it is true.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)

Sequence Allocation
Select the option that describes the constraints on $N_1$ or $N_2$ or both.

The options are

- **Equal ($N_1 = N_2$)**
  This selection is used when you wish to have equal sample sizes in each sequence. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter $N_2$, solve for $N_1$**
  Select this option when you wish to fix $N_2$ at some value (or values), and then solve only for $N_1$. Please note that for some values of $N_2$, there may not be a value of $N_1$ that is large enough to obtain the desired power.

- **Enter $R = N_2/N_1$, solve for $N_1$ and $N_2$**
  For this choice, you set a value for the ratio of $N_2$ to $N_1$, and then PASS determines the needed $N_1$ and $N_2$, with this ratio, to obtain the desired power. An equivalent representation of the ratio, $R$, is

  \[ N_2 = R \times N_1. \]

- **Enter percentage in Sequence 1, solve for $N_1$ and $N_2$**
  For this choice, you set a value for the percentage of the total sample size that is in Sequence 1, and then PASS determines the needed $N_1$ and $N_2$ with this percentage to obtain the desired power.

N2 (Sample Size, Sequence 2)
This option is displayed if Sequence Allocation = “Enter $N_2$, solve for $N_1$”

$N_2$ is the number of items or individuals sampled from the Sequence 2 population.

$N_2$ must be $\geq 2$. You can enter a single value or a series of values.

R (Sequence Sample Size Ratio)
This option is displayed only if Sequence Allocation = “Enter $R = N_2/N_1$, solve for $N_1$ and $N_2$.”

$R$ is the ratio of $N_2$ to $N_1$. That is,

\[ R = N_2 / N_1. \]

Use this value to fix the ratio of $N_2$ to $N_1$ while solving for $N_1$ and $N_2$. Only sample size combinations with this ratio are considered.

$N_2$ is related to $N_1$ by the formula:

\[ N_2 = \lceil R \times N_1 \rceil, \]

where the value $\lceil Y \rceil$ is the next integer $\geq Y$. 
For example, setting $R = 2.0$ results in a Sequence 2 sample size that is double the sample size in Sequence 1 (e.g., $N_1 = 10$ and $N_2 = 20$, or $N_1 = 50$ and $N_2 = 100$).

$R$ must be greater than 0. If $R < 1$, then $N_2$ will be less than $N_1$; if $R > 1$, then $N_2$ will be greater than $N_1$. You can enter a single or a series of values.

**Percent in Sequence 1**
*This option is displayed only if Sequence Allocation = “Enter percentage in Sequence 1, solve for $N_1$ and $N_2.”*

Use this value to fix the percentage of the total sample size allocated to Sequence 1 while solving for $N_1$ and $N_2$. Only sample size combinations with this Sequence 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

**Sample Size (When Not Solving for Sample Size)**

**Sequence Allocation**
Select the option that describes how individuals in the study will be allocated to Sequence 1 and to Sequence 2. The options are

- **Equal ($N_1 = N_2$)**
  This selection is used when you wish to have equal sample sizes in each sequence. A single per sequence sample size will be entered.

- **Enter $N_1$ and $N_2$ individually**
  This choice permits you to enter different values for $N_1$ and $N_2$.

- **Enter $N_1$ and $R$, where $N_2 = R * N_1$**
  Choose this option to specify a value (or values) for $N_1$, and obtain $N_2$ as a ratio (multiple) of $N_1$.

- **Enter total sample size and percentage in Sequence 1**
  Choose this option to specify a value (or values) for the total sample size ($N$), obtain $N_1$ as a percentage of $N$, and then $N_2$ as $N - N_1$.

**Sample Size Per Sequence**
*This option is displayed only if Sequence Allocation = “Equal ($N_1 = N_2$).”*

The Sample Size Per Sequence is the number of items or individuals sampled. Since the sample sizes are the same in each sequence, this value is the value for $N_1$, and also the value for $N_2$.

The Sample Size Per Sequence must be $\geq 2$. You can enter a single value or a series of values.

**$N_1$ (Sample Size, Sequence 1)**
*This option is displayed if Sequence Allocation = “Enter $N_1$ and $N_2$ individually” or “Enter $N_1$ and $R$, where $N_2 = R * N_1.”*

$N_1$ is the number of items or individuals sampled from the Sequence 1 population.

$N_1$ must be $\geq 2$. You can enter a single value or a series of values.

**$N_2$ (Sample Size, Sequence 2)**
*This option is displayed only if Sequence Allocation = “Enter $N_1$ and $N_2$ individually.”*

$N_2$ is the number of items or individuals sampled from the Sequence 2 population.

$N_2$ must be $\geq 2$. You can enter a single value or a series of values.
R (Sequence Sample Size Ratio)

This option is displayed only if Sequence Allocation = “Enter N1 and R, where N2 = R * N1.”

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1} \]

Use this value to obtain N2 as a multiple (or proportion) of N1.

N2 is calculated from N1 using the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \( \lceil Y \rceil \) is the next integer \( \geq Y \).

For example, setting \( R = 2.0 \) results in a Sequence 2 sample size that is double the sample size in Sequence 1.

R must be greater than 0. If \( R < 1 \), then N2 will be less than N1; if \( R > 1 \), then N2 will be greater than N1. You can enter a single value or a series of values.

Total Sample Size (N)

This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”

This is the total sample size, or the sum of the two sequence sample sizes. This value, along with the percentage of the total sample size in Sequence 1, implicitly defines N1 and N2.

The total sample size must be greater than one, but practically, must be greater than 3, since each sequence sample size needs to be at least 4.

You can enter a single value or a series of values.

Percent in Sequence 1

This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”

This value fixes the percentage of the total sample size allocated to Sequence 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

M (Number of Replicates)

Enter one or more values for M: the number of replicates in a 2 × 2M replicated cross-over design. M is the number of times each treatment is measured on each subject.

For example, M = 2 refers to a 2 × 4 replicated cross-over design. The two sequences used for this design are often

- **Sequence 1**: R T R T
- **Sequence 2**: T R T R.

You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.

The range is \( M \geq 2 \).
Effect Size

R0 (Superiority Variance Ratio)
Enter one or more values for the superiority limit of the ratio of the two total variances ($\sigma^2_{tt} / \sigma^2_{tc}$) assumed by the null hypothesis, H0. The sample variance ratio is compared to this value when conducting the test.

This value must be less than one. Popular choices are 0.8 and 0.5.

R1 (Actual Variance Ratio)
Enter one or more values for total variance ratio assumed by the alternative hypothesis. This is the value of $\sigma^2_{tt} / \sigma^2_{tc}$ at which the power is calculated.

The range of possible values is $0 < R1 < R0$.

$\sigma^2_{tc}$ (Control Variance)
Enter one or more values for the total variance of the average subject control measurements.

This value will have to be determined from a previous study or a pilot study.

The range of possible values is $\sigma^2_{tc} > \sigma^2_{wc}$.

$\sigma^2_{wt}$ (Treatment, Within-Subject Variance)
Enter one or more values for within-subject variance of the treatment measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is $\sigma^2_{wt} > 0$.

$\sigma^2_{wc}$ (Control, Within-Subject Variance)
Enter one or more values for within-subject variance of the control measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is $\sigma^2_{wc} > 0$.

$\rho$ (Treatment, Control Correlation)
Enter one or more values for the between-subject (intersubject) correlation. This is the correlation between the two group means, treatment and control, calculated on each subject. That is, the means are averaged across replicates within a subject.

This value will have to be determined from a previous study or a pilot study.

The range of possible values is $-1 \leq \rho \leq 1$. 
Example 1 – Finding Sample Size

A company has developed a generic drug for treating rheumatism and wants to show that it is superior to the standard drug in terms of the total variability. A 2 x 4 cross-over design will be used to test the superiority.

Company researchers set the superior limit to 0.8, the significance level to 0.05, the power to 0.90, M to 2, and the actual variance ratio values between 0.4 and 0.7. They also set $\sigma^2_{tc} = 0.8$, $\sigma^2_{wt} = 0.2$, $\sigma^2_{wc} = 0.3$, and $\rho = 0.7$. They want to investigate the range of required sample size values assuming that the two sequence sample sizes are equal.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Superiority by a Margin Tests for Total Variances in a 2×2M Replicated Cross-Over Design procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option Value

Design Tab
Solve For Sample Size
Power 0.90
Alpha 0.05
Sequence Allocation Equal (N1 = N2)
M (Number of Replicates) 2
R0 (Superiority Variance Ratio) 0.8
R1 (Actual Variance Ratio) 0.4 0.5 0.6 0.7
$\sigma^2_{tc}$ (Control Variance) 0.8
$\sigma^2_{wt}$ (Treatment Variance) 0.2
$\sigma^2_{wc}$ (Control Variance) 0.3
$\rho$ (Treatment, Control Correlation) 0.7

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

| Actual Power | Seq 1 Sample Size | Seq 2 Sample Size | Num Reps | M | R0 (Super Var Ratio) | R1 (Actual Var Ratio) | Total Var Cntl Trt | Wthn Subj Var Cntl | Wthn Subj Var Trt | Corr Trt vs Cntl Cntl | Alpha |
|--------------|-----------------|-----------------|----------|---|-----------------|-----------------|-----------------|----------------|----------------|----------------|----------------|-------|
| 0.9024       | 26              | 26              | 52       | 2 | 0.800           | 0.400           | 0.800           | 0.200          | 0.300          | 0.700          | 0.050           |
| 0.9025       | 47              | 47              | 94       | 2 | 0.800           | 0.500           | 0.800           | 0.200          | 0.300          | 0.700          | 0.050           |
| 0.9018       | 112             | 112             | 224      | 2 | 0.800           | 0.600           | 0.800           | 0.200          | 0.300          | 0.700          | 0.050           |
| 0.9001       | 490             | 490             | 980      | 2 | 0.800           | 0.700           | 0.800           | 0.200          | 0.300          | 0.700          | 0.050           |

References
Report Definitions
Actual Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly larger than the target power.
N1 is the number of subjects in sequence 1.
N2 is the number of subjects in sequence 2.
N is the total number of subjects. N = N1 + N2.
M is the number of replicates. That is, it is the number of times a treatment measurement is repeated on a subject.
R0 is the superiority by a margin limit for the total variance ratio.
R1 is the value of the total variance ratio at which the power is calculated.
\( \sigma^2_{tc} \) is the total variance of measurements in the control group. Note that \( \sigma^2_{tc} = \sigma^2_{wc} + \sigma^2_{wt} \).
\( \sigma^2_{wt} \) is the within-subject variance of measurements in the treatment group.
\( \sigma^2_{wc} \) is the within-subject variance of measurements in the control group.
\( \rho \) is the between-subject correlation of the average subject treatment-group measurements versus the average subject control-group measurements.
Alpha is the probability of rejecting a true null hypothesis, H0.

Summary Statements
A study is being conducted to assess the superiority by a margin of the total variance of a treatment group to a control group using a hypothesis test of data from a replicated cross-over design. Sequence sample sizes of 26 and 26 achieve 90% power to reject the null hypothesis at a significance level of 0.050. The superiority limit is 0.800. The variance ratio at which the power is calculated is 0.400. The number of times each treatment measurement is repeated on a subject is 2. The actual total variance of the control group is assumed to be 0.800. The actual within-subject variance of the treatment group is assumed to be 0.200. The actual within-subject variance of the control group is assumed to be 0.300. The between-subject correlation between the average treatment measurement per subject and the average control measurement per subject is assumed to be 0.700.

This report gives the sample sizes for the indicated scenarios.

Plot Section

This plot shows the relationship between sample size and R1.
Example 2 – Validation using Hand Calculations

We could not find an example in the literature, so we will present hand calculations to validate this procedure.

Set N1 = 47, R0 = 0.8, significance level = 0.05, M = 2, and R1 = 0.5. Also, $\sigma^2_{tc} = 0.8$, $\sigma^2_{wt} = 0.2$, $\sigma^2_{wc} = 0.3$, and $\rho = 0.7$. Compute the power for the superiority test.

The calculations proceed as follows.

$$\sigma^2_{TT} = R1(\sigma^2_{tc}) = 0.5(0.8) = 0.4$$
$$\sigma^2_{BT} = \sigma^2_{TT} - \sigma^2_{WT} = 0.4 - 0.2 = 0.2$$
$$\sigma^2_{BC} = \sigma^2_{TC} - \sigma^2_{WC} = 0.8 - 0.3 = 0.5$$

$$\sigma^2 = 2\left[\left(\frac{\sigma^2_{BT}}{M}\right)^2 + R_0^2\left(\frac{\sigma^2_{BC}}{M} + \frac{\sigma^2_{WC}}{M}\right)^2 + \frac{(M-1)\sigma^2_{WT}}{M^2} + \frac{(M-1)R_0^2\sigma^4_{TC}}{M^2} - 2R_0\sigma^2_{BT}\sigma^2_{BC}\rho^2\right]$$

$$\sigma^2 = 2\left(0.2 + \frac{0.2^2}{2}\right)^2 + 0.64\left(0.5 + \frac{0.3^2}{2}\right)^2 + \frac{0.04}{4} + \frac{0.64(0.09)}{4} - 2(0.8)(0.2)(0.5)(0.49)$$

$$\sigma^2 = 2[0.09 + 0.2704 + 0.01 + 0.0144 - 0.0784] = 0.6128$$

Power = $\Phi\left(z_{\alpha} - \frac{(R_1 - R_0)\sigma^2_{TC}}{\sqrt{\sigma^2/N_s}}\right)$

Power = $\Phi\left(-1.6448536 - \frac{(0.5 - 0.8)0.8}{\sqrt{0.6128/92}}\right)$

Power = $\Phi(-1.6448536 + 2.94066652)$

Power = $\Phi(1.29581292) = 0.90248003$

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Superiority by a Margin Tests for Two Total Variances in a 2×2M Replicated Cross-Over Design procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Sequence Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Sequence</td>
<td>47</td>
</tr>
<tr>
<td>M (Number of Replicates)</td>
<td>2</td>
</tr>
<tr>
<td>R0 (Superiority Variance Ratio)</td>
<td>0.8</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>0.5</td>
</tr>
<tr>
<td>$\sigma^2_{tc}$ (Control Variance)</td>
<td>0.8</td>
</tr>
<tr>
<td>$\sigma^2_{wt}$ (Treatment Variance)</td>
<td>0.2</td>
</tr>
<tr>
<td>$\sigma^2_{wc}$ (Control Variance)</td>
<td>0.3</td>
</tr>
<tr>
<td>$\rho$ (Treatment, Control Correlation)</td>
<td>0.7</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

```
| Power  | Seq 1 Sample Size | Seq 2 Sample Size | Num Reps | Super Marg Var Ratio | Actual Var Ratio | Total Var Cntl | Total Var Trt | Wthn Subj Var Cntl | Wthn Subj Var Trt | Corr Trt Cntl | Corr Trt | Alpha |
|--------|-------------------|-------------------|----------|-----------------------|------------------|----------------|---------------|------------------|------------------|--------------|----------|
| 0.9025 | 47                | 47                | 94       | 2                     | 0.800            | 0.500          | 0.800         | 0.200            | 0.300            | 0.700        | 0.050    |
```

The power matches the result calculated by hand above.